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3.Installation procedure for DAQ-PAC-F4X

3.1

General

AutoResp™ 4 is a piece of PC software designed to perform automated intermittent
flow respirometry together with the DAQ-4 instrument.

AutoResp™ 4 requires Windows XP running on a PC with an Intel Pentium IV
processor of minimum 2.66 GHz or equivalent. The PC must have at least 256 MB
memory and at least 1GB of free hard disk space. A minimum resolution of
1024x768 pixels is required.

AutoResp™ 4 communicates with the DAQ-4 instrument via the accompanying USB
cable which must be connected.

AutoResp™ 4 can handle two different types of oxygen inputs. Either 0-5 VDC
analog input (OXY-CH1-4) or serial inputs when using OXY-4 mini instrument
manufactured by PreSens.

If chamber oxygen is measured using the OXY-4 mini instrument one RS232 male
DB9 connector must be available on the PC. If not available use an USB 232
adapter, e.g. USB Serial Adapter manufactured by VSCOM.

If using the OXY-4 mini instrument turn this on before starting AutoResp™ 4.

Input labels, see Table 1.

Table 1
DAQ-4 instrument label AutoResp™ 4 signal name
OXY-CH1 Chamber oxygen 1
OXY-CH2 Chamber oxygen 2
OXY-CH3 Chamber oxygen 3
OXY-CH4 Chamber oxygen 4
OXY-AM Ambient oxygen
TEMP Temperature

Output labels, see Table 2.
Table 2
DAQ-4 instrument label AutoResp™ 4 indicator name
FLUSH Flush
RECIRC Recirc.
D2/N2 Ambient O, (kPa)
TEMP Temperature (°C)
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3.2 DAQ-4 instrument

3.2.1. Front side
OXY-CH1: Analog oxygen input for chamber 1. The input range is 0-5 VDC.
OXY-CH2: Analog oxygen input for chamber 2. The input range is 0-5 VDC.
OXY-CH3: Analog oxygen input for chamber 3. The input range is 0-5 VDC.
OXY-CH4: Analog oxygen input for chamber 4. The input range is 0-5 VDC.

Connect analog oxygen inputs, e.g. from an OXY-REG, via pin 1 (+) and pin 4 (GND) in the
input connector.

OXY-AM: Analog oxygen input for ambient water. The input range is 0-5
VDC.

Connect analog oxygen input to the OXY-REG instrument via the accompanying data cable.

TEMP: Analog temperature input for ambient water. The input range is 0-
5 VDC.

Connect analog temperature input to the TMP-REG instrument via the accompanying data
cable.

PC: USB port for PC communication. Use the USB cable to connect the
DAQ-4 instrument to the PC.

LEDS: Relay status LEDs.

IMPORTANT: DO NOT connect DAQ-4 instrument to PC before installation of
driver from Measurement & Automation software from National
Instruments is completed. The software will be installed together
with the installation of AutoResp™ 4, see AutoResp™ 4 software
for Windows page 6.
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3.2.2. Back side

FLUSH: Relay socket for 110/230VAC (max 3A) flush pumps.

Connect one or more pumps by using one of the 4-fold power strips.

RECIRC: Relay socket for 110/230VAC (max 3A) recirculation pump.

Connect one or more pumps by using one of the 4-fold power strips.

02/N2: Relay socket for 110/230VAC (max 3A) for solenoid valve. Use
oxygen or nitrogen for hyperoxic or hypoxic control.

Connect the solenoid valve by using the push-in fittings.

TEMP: Relay socket for 110/230VAC (max 3A) heating/cooling pump.

Connect the heating/cooling pump by using the adapter cable.

100-240VAC 50-60 Hz: Power input for the DAQ-4 instrument.

Connect the instrument to a grounded 110/230VAC power supply using a standard pc-type
cable with a grounded wall plug.

Power button: Turns the instrument on and off.

IMPORTANT: DO NOT connect any of the relay sockets to >3 amps equipment! USE grounded
outlets only!

For further information about the DAQ-4 instrument see 8.3 DAQ-4 Instruction manual, page
52.
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3.3 AutoResp™ 4 software for Windows

The following steps will explain how to install AutoResp™ 4 and drivers on your computer.

1. Insert the CD labelled AutoResp™ 4 and wait until you see Screen 1. If you do NOT se
the screen, browse to the root of your CD and double click on the icon labelled
AR4.exe.

Screen 1

AutoResp 4 Installation

The installation iz initializing. Please
waik...

Cancel

2. After the installation is initialized, click Setup to start the installation.

WinZip Self-Extractor - AutoResp.exe
E Click Setup to install AutcFesp 4. =i

Cancel

Screen 2

About
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3. Click Install to start the installation of AutoResp™ 4 and all necessary drivers.

Screen 3

AutoResp 4 Installation

Readme

eloome to the AutoResp 4 Installer. ou will now install AutaResp 4 and all
cessany divers.

If azked if you want to restart, pleaze don't click on restart until later. *Your pc should
| not be restarted until the entire installation is completed.

Lancel

4. Click Next to start installation of AutoResp™ 4.

Screen 4

L AutoResp™ 4 L:JD -

Welcome to the AutoRespl 4 installer

Please follow the instructions on screen and wait until pou are asked to restart
your camputer... i

L

<< Back Mext > ] [ Cancel

5. Click Next.
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On Screen 5 the product information of the products to be installed are shown.

Screen 5

(Q_iﬂ AutoResp™ 4 g

Product Information

Please read the fallowing infarmation about the products to be
installed.

NI-DAQ 8.5 Device Support

WI-DAQ M 8.5 supports the latest DAD devices, including C Series, M Series, E Series. S Series, B Series, USE
Series, Analog Dutput/ W aveform, Counter/Timer, Digital 120, WI-B53%, DS54, S04, and S5CC devices. The last
wersion of NI-DAGmx to suppart the PCI-7041 /B040E device iz 8.1; if vou need support for this device, do nat install
thiz version of MI-Dalms. Refer to the NI-DaQ Readme for supported device models. Tradiional NI-DAD [Legacy)
iz an older driver with an autdated AP that supparts some additional older DAD devices, but nat all of the latest DAL
dewvices. Applications developed with earlier versions of NI-DAL will run under Traditional N1-DAG [Legacy). You can
uze both MI-DAGmx and Traditional MI-DAD [Legacy] in the zame computer, but must reset devices before chanaing
from Traditional NI-DAD [Legacy) to NI-DAGm:=. Refer ta the NI-DAQ Readme for guidelines.

Support Removed from MI-DAQ 7.0 and later

MI-DAL 7.0 and later supparts different devices, operating spstems, application software, and prograniming language
versions than previous releases of NI-DAL. Starting with version 7.0, NI-DAQ device suppart excludes Wl DAD,
Remate ST, 1200 Series DAL, the DAQCard-500,/700 family, parallel part DAL Pads, and several other older
devices. Do not install MI-DAQ 7.0 or later if your existing applications include unsupported components. Refer to the
WI-DAL Readme file on the distribution.

SaveFiIe...][ < Back ][ Mext >3 ] [ Cancel

6. Click Next.

7. Select destination directory for AutoResp™ 4 and for the National Instruments driver.

Screen 6

5/ AutoResp™ 4 [g Cl @W

Destination Directory
Select the primary inztallation directory.

All zoftware will be inztalled in the following location(z). To install software into a
different location(s), click the Browse button and select another directony.

Directony for AutoRespl 4

|C:"-.Prc-g|am Files"\AutoResp™ 4% | [ Browse... ]

Drirectory for Mational Inztruments products

|C:"-.F‘roglam Files .National Instruments®. | [ Browse... ]

<< Back " Mext > ‘ [ Cancel

8. Click Next.
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9. If you accept the License Agreement, please select “I accept the License Agreement(s).

Screen 7

(i—f? AutoResp™ 4

License Agreement
You rust accept the license(s) displayed below to proceed.

AEX]

NATIONAL INSTRUMENTS SOFTWARE LICENSE AGREEMENT

INSTALLATION MOTICE: THIS IS A CONTRACT. BEFORE YOU DOWNLOAD THE SOFTWARE
AMDIOR COMPLETE THE INSTALLATION PROCESS, CAREFULLY READ THIS AGREEMENT. BY
DOWMNLOADING THE SOFTWARE AND/OR CLICKING THE APFPLICABLE BUTTON TO
COMPLETE THE INSTALLATION PROCESS, YOU CONSENT TO THE TERMS OF THIS
AGREEMEMT AND YOU AGREE T BE BOUND BY THIS AGREEMENT. IF ¥YOU DO NOT WISH TO
BECOME A PARTY TO THIS AGREEMENT AND BE BOUND BY ALL OF ITS TERMS AND

CONDITIONS, CLICK THE APPROPRIATE BUTTON TO CANCEL THE INSTALLATION PROCESS,

DO MNOT INSTALL OR USE THE SOFTWARE, AND RETURN THE SOFTWARE WITHIN THIRTY
(30} DAYS OF RECEIPT OF THE SOFTWARE (INCLUDING ALL ACCOMPANYING WRITTEN
MATERIALS, ALOMG WITH THEIR CONTAINERS) TO THE PLACE YOU OBTAINED THEM. ALL
RETURMS SHALL BE SUBJECT T MI'S THEM CURRENT RETURM POLICY.

% Definitions. As used in this Agreement, the following terms have the following
meanings:

(3) | accept the License Agreement(s).
()| do not accept the License Agreement(s).

]

el

[ << Back H Mext >3 ] [ Cancel

l

10.Then click Next.

On Screen 8 a summary is given of the products to be installed.

Screen 8

(‘.'_«J AutoResp™ 4

Start Installation
Review the following summary before continuing.

Adding or Changing

» AutoRespl 4 Files

s MI-DA O 8.5

» Ml LabWIEW Run-Time Engine 7.1.1

s Ml Measurement & Automation Explarer 4.2

Click the Mext button to begin installation. Click the Back button to change the installation settings.

SaveFiIe...” <4 Back ” Mext > ] ’ Cancel

11.Click Next.
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Screen 9

[I‘I' AutoResp™ 4 E] d 1

Owerall Progress

| |

Cumently installing NI Assistant Framework LabVIEW Code Generator 6.1, Part 1of 58.

<< Back Mext > Cancel

The installation may take a while.
When installation is complete Screen 10 becomes present.

Screen 10

(iﬂ_‘ AutoResp™ 4 E] O W

Installation Complete

The installer has finished updating your system.

Back MNext > Caricel

12.Click Next to end installation of AutoResp™ 4.
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13.Now the WiBu drivers will be installed. When Screen 11 appears, click Next. LOLIGOSYSTEMS.COM

Screen 11

‘whelcome to the WIBU-KEY Software Setup progran.
This pragram will inztal ‘\WIBU-KLEY Software on wour
= computer.

Itiz strongly recommended that you exit all Windows pragrams [and the
control panel] before running this Setup program.

Click sCancels to quit Setup and then cloze any programs you have
Unning.
Click sMexts to continue with the Setup progran.

Wersion 5.20b
MNest > i Cancel

Install

14.Select supported language, and click Next.
15.Select the options seen on Screen 12, and click Next.

Screen 12

ad the follawing |nfarmatiorn.

#2 WIBU-KEY, Setup

Select the WIBU-KEY components vou like to install:

[ Install as NT service with autostart
[ wikNet Network Server for Novell Metware
IV Wik LA AW kN et Metwark Maonitar (32 bit)
i ;
=5

Once you have selected the components you wish ta install,
press the =Mexts button to complete the installation.

< Back l Hext > l

< Back Install
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16.Click Next again after you have accepted the summary of the installation. LOLIGOSYSTEMS.COM

Screen 13

Readme

Fle: ad the follawing [nfarmation.

#2 WIBU-KEY Setup

If you press :Mests the following tasks will be performed:

Operating system: 'Windows P
Source path:

Selected languages:
English

The following components will be installed:
WIBL-KEY diiver filles

WwWBLU-KEY COM control
WIBU-5YSTEMS Shell Extension
WIBU-KEY network server

WIBU-KEY taols

Cancel

Install

17.When installation is done, click Next again.
18.Click Finish to end installation of the WiBu drivers.

19.Close all open programs and choose “Yes, I want to restart my computer now”, and
click on Finish.

Screen 14

AutoResp 4 Installation

arted. Do vou want to

< Back Cancel
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The following steps will explain how to finish the installation of the drivers together with your
instruments.

20.Connect the WiBu dongle to your computer via an USB port. The dongle will be
detected automatically.

21.Connect the DAQ-4 instrument to the PC via the USB cable. After a few seconds Screen
15 becomes present.

Screen 15

Found Mew Hardware Wizard

Welcome to the Found New

Hardware Wizard

Viindows will earch for cument and updated software by
loaking on your computer, on the hardware installation CD, or an
the Windows Update Web site (with your permission}.

Can Windows connect to Windows Update to search for
software ?

) Yes, this time only

) Yes, now and every time | connect a device

() Mo, not this time

Click Mext to continue.

et = ][ Cancel

22.Click on “No, not this time” and then on Next.
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Screen 16

Found New Hardware Wizard

5

This wizard helps you install software for:

USB-621x Loader

'j i your hardware came with an installation CD
e orfloppy disk. insert it now.

What do you want the wizard to do?

{®) Install the software automatically (Recommended)
(") Install from a list or specific location (Advanced)

Click Mext to continue.

[ < Back ” Mext = ][ Cancel

l

LOLIGOSYSTEMS.COM

23.Click on “Install the software automatically (Recommended)” and then on Next.

Screen 17

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

5

The wizard has finished installing the software for:

‘? IUSB-621x Loader
’

Click Finish to close the wizand.

Finish

24.Click Finish.
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F

Found Hew Hardware Wizard

Welcome to the Found New
% Hardware Wizard

3

looking on your computer, on the hardware installation CD, or an
the Windows Update Web site {with yvour permission].

Can Windows connect to Windows Update to search for
software?

() Yas, this tims only
") Yes, naw and every time | connect a device

{®) Mo, not this time

Click MNext to continue.

[ e = ][ Cancel

25.Click on "No, not this time” and then on Next.

Screen 19
Found Mew Hardware Wizard

Ny
S
This wizard helps you install software for:

U5B-6215

I":-‘\‘l if your hardware came with an installaticn CD
2 or floppy disk. insert it now.

VWhat do you want the wizard to da?

{(#) Install the software automatically (Recommended)
() Install from a list ar specific location {Advanced]

Click Mext to continue.

[ < Back ” Mexd > |[ Cancel I

26.Click on “Install the software automatically (Recommended)” and then on Next.
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‘Found New Hardware Wizard

5

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

7 USB-6215
b

Click Finish to close the wizard.

27.Click Finish.

Screen 21

@ Quattro Track
@ LolTRACK

E Microsoft Excel
AutoResp®@4
@ Measurement & Auty
‘g Paint

Allprograms [

rsEr IEE

] Mew Office Document
[&] newshorteutz

‘& Open Office Document

@ SetProgram Access and Defaults
W Windows Catalog

& windows Update

D winzip

() Accessories »

(@) AcerePm 3

[ Acer Gridvista 3

[ Acersystem 3
1| @ antvir personaiditon Classic ’

€250 - Muti-Channel Gas Exchange Saftware b

CyberLink PawerDVD 3
() ettima Software 3
) Games 3
[ LABTECH NOTEBOOKpro Version 12,1 3
[ Launch Manager 3
[ Measurement Computing »
[ Microsoft Office Toals »
f§ii National In: >
[#) NTI Backup NOW! 4 »
[ NTIC 8DVD-Maker 7 3
[ Phiips SPC S00NC PC Camera r
[ Phiips Tolcam Camera 3
[ Prnade PCTV USB2 »
[ REALTEX Gigabit and Fast Ethernet NIC Driver
@ stertun »
[T verrier Software 3
@ winzip 3

gl adobe Reader 7.0
@ Internet Explorer

LoliResp
Microsoft Access
Microsoft Excel

B ricrosoft FrontPage
K& microsoft Outiook

icrosoft PowerPoint

Microsoft Werd
[5) Outlock Express
. Remote Assistance
& Windows Meda Player
@ Windows Mavie Maker
QuickTime

&8 Windows Live Messenger
@
I LolTRACK
1@ canon Utities
i) Autorespd

WIBU-KEY

@@ niDaQ

& Measurement & Automation

G NIRegstration Wizard

) Datasocket

[ visa

G 1 License Manager

_

Microsoft I ""
Windows

Home Edition

EEMHAEYAD B, s

I_OLIGO
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28.0pen Measurement & Automation by following the folder hierarchy shown on Screen

21.
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Screen 22 LOLIGOSYSTEMS.COM

l@ NI USB-6215: "Dev1" - Measurement & Automation Explorer um

File Edit View Tools Help

Conﬁguration 22| & Properties | X Delete Eiﬁ Self-Test Test Panels. .. ‘; Reset Device {% Create Task... | & Configure TEDS... ke | S8 Hide Help |

=&} My System =

- 3 Data Neighborhood Mame Value Back _EE_I .QJ

- (B Devices and Tnterfaces I serial Number OxEBEF2

. - M-DAQMX Devices NI-
- DAGmx Device

i m-PXIPXI System (Unidentified)
[ Scales

(@ Software

] @ Remote Systems

Basics

What do you want
to do?

=+ Bun the MNI-DACMX
TestPanels

<+ Bemove the
device

<+ Wiew or change
device properties

Y Atibutes I @ Device Ruutesl A Calibmtionl (F2) ——

mﬁ 1§ screen 21.bmp -Paint @g@ggﬂ Emdo 2l a5

Make sure the NI USB-6215 is installed as device name “Dev1”. If so the DAQ-4 instrument is
now properly correct installed and ready for use with AutoResp™ 4.

29.Remove CD labelled AutoResp™ 4.

30.You have now installed AutoResp™ 4 and all necessary drivers. AutoResp™ 4 is now
ready for use, see Using AutoResp™ 4, page 25 for help starting AutoResp™ 4.
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3.4 OXY-4 mini instrument

3.4.1. Front side
CH1: Fiber optic oxygen input for chamber 1.
CH2: Fiber optic oxygen input for chamber 2.
CH3: Fiber optic oxygen input for chamber 3.
CH4: Fiber optic oxygen input for chamber 4.

Connect an oxygen sensor, e.g. oxygen needle type probe, to an input.

LINE: Indicates instruments ON/OFF
3.4.2. Back side
Power connector: Power input for the OXY-4 mini instruments.

Connect the instrument to a grounded 230 VDC power supply using a standard pc-type cable
with a grounded wall plug.

Power button: Turns instrument on and off.
DATA: RS-232 interface (male).

Connect the OXY-4 mini instrument to the PC via a RS-232 cable.

For further information about the OXY-4 mini instrument see 8.6 OXY-4 Instruction manual,
page 55

Page 18 of 55



LOLIGOSYSTEMS.COM

3.5 TMP-REG instrument

The TMP-REG instrument is designed for monitoring and regulating water temperature in fish
tanks, respirometers etc.

3.5.1. Front side

IN: Pt100 temperature input.

Connect the Pt100 temperature sensor to this input.

3.5.2. Back side

ANALOG OUT: Analog temperature output. The output range is 0-5 VDC.

For using the TMP-REG instrument in general the signal is available via pin 1 (+) and pin 4
(GND) in the input connector.

RE1: Relay socket for 110/230VAC (max 3A) pump, cooling or heating
coil.

RE2: Relay socket for 110/230VAC (max 3A) pump, cooling or heating
coil.

POWER 24...230V UC: Power input for the TMP-REG instrument.

Connect the instrument to a grounded 24/230 VDC power supply using a standard pc-type
cable with a grounded wall plug.

For further information about the TMP-REG instrument see 8.4 TMP-REG manual, page 55.
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3.6 OXY-REG instrument

The OXY-REG instrument is designed for monitoring and regulating dissolved oxygen content
of sea or fresh water in fish tanks, respirometers, aquaria etc.

3.6.1. Front side

IN: Analog oxygen input. The input range is 0-50 mVDC.

Connect the galvanic oxygen probe to this input.

0-cal button Button for use for calibration of oxygen signal.
3.6.2. Back side
ANALOG OUT: Analog oxygen output. The output range is 0-5 VDC.

For using the OXY-REG instrument in general the signal is available via pin 1 (+) and pin 4
(GND) in the input connector.

RE1: Relay socket for 110/230VAC (max 3A) solenoid valve.
RE2: Relay socket for 110/230VAC (max 3A) solenoid valve.
POWER 24...230V UC: Power input for the OXY-REG instrument. Connect the instrument

to a grounded 24/230 VDC power supply using a standard pc-type
cable with a grounded wall plug.

For further information about the OXY-REG instrument see 8.5 OXY-REG manual, page 55.
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4.Introduction to intermittent flow respirometry

Three different methods are commonly used for measuring oxygen consumption in water
breathers, e.g. fish:

e Closed respirometry
e Flow-through respirometry

e Intermittent flow respirometry

4.1 Closed respirometry (or constant volume
respirometry)

Measurements are in a sealed chamber of known volume (a closed respirometer). The oxygen
content of the water is measured initially (ty), then the respirometer is closed and at the end of
the experiment (t;) the oxygen content is measured again.

Knowing the body weight of the animal, the respirometer volume and the oxygen content of
the water at time ty and t; the mass specific oxygen consumption rate can be calculated as
follows:

VO, = ([O2]to - [02]t) « V/t - BW™

VO, = oxygen consumption rate (mg O,/kg/hour)

[02]t = oxygen concentration at time t, (mg O,/liter)

[0;]t, = oxygen concentration at time t; (mg O,/liter)

V = respirometer volume minus volume of experimental animal (liter)
t =t; - to (hour)

BW = body weight of experimental animal (kg)

An advantage of this method is its simplicity. A disadvantage is that the measurements are
never made at a constant oxygen level, due to the continuous use of oxygen by the animal
inside the respirometer. This might cause problems when interpreting data, since animal
respiration often changes with ambient oxygen partial pressure.

Furthermore, metabolites from the experimental animal, i.e. CO,, accumulate in the water,
thus limiting the duration of measurements. This limited time for measurements prevents the
experimental animal to recover from initial handling stress that often increase fish respiration
significantly and for several hours, thus overestimating oxygen consumption rates.
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4.2 Flow-through respirometry (or open respirometry)

This is a more sophisticated method for oxygen consumption measurements. Experimental
animals are placed in a flow-through chamber, with known flow rate. Oxygen is measured in
the inflow and outflow and oxygen consumption rate can be calculated as:

VO, =F - ([O2]in = [O2]out) /BW

VO, = oxygen consumption rate (mg O,/kg/hour)

F = water flow rate (I/hour)

[O2]in = oxygen content in water inflow (mg O,/liter)
[O2]out = oxygen content in water outflow (mg O,/liter)
BW = body weight of experimental animal (kg)

The advantages of this method are several:
1) the duration of the experiment is in principle unlimited
2) no accumulation of CO, and other metabolites
3) its possible to measure at a constant oxygen level
4) by controlling the quality of the inflowing water it's possible to measure
metabolism at different desired levels of oxygen, salinity etc.

However, this method bring along one significant disadvantage: in order to determine oxygen
consumption by open respirometry it is crucial that the system is in steady state. This means
that the oxygen content of the in flowing and out flowing water, AND the oxygen consumption
of the animal have to be constant.

If the oxygen consumption of the animal for some reason changes during the experiment,
steady state will not exist for a while. Not until the system is in steady state again will the
above formula give the correct oxygen consumption rate. The duration of the time lag depends
on the relationship between chamber volume and flow rate. Thus, open respirometry
measurements have poor time resolution and are not suitable for determination of oxygen
consumption on organisms with a highly variable respiration like fish.

Page 22 of 55



LOLIGOSYSTEMS.COM

4.3 Intermittent flow respirometry (or open-closed
respirometry)

Our systems for automatic respirometry works by intermittent flow respirometry aiming at
combining the best of both 1) closed and 2) flow-through respirometry.

Reference: Steffensen, J.F. (1989). Some errors in respirometry of aquatic breathers: how to
avoid and correct for them. J. Fish. Physiol. Biochem. 6; 49-59.

The experimental animal is placed in a closed chamber (respirometer) immersed in an ambient
tank.

A recirculation pump ensures proper mixing of the water inside the respirometer and adequate
flow past the oxygen probe. A second pump can change the water inside the respirometer with
ambient water.

During measurements of oxygen consumption, this flush pump is turned off and the systems
operates like 1) closed respirometry. Then the pc controlled flush pump turns on pumping
ambient water into the respirometer and bringing the oxygen content back to pre
measurement values.

In this way, problems with accumulating metabolites and severe changes in oxygen level due
to animal respiration are avoided.

As with open respirometry, the duration of the experiment is in principle unlimited.

However, the most important advantage is the great time resolution of this method. Oxygen
consumption rates of animals can be determined for every 10" minutes over periods of hours
or days, making the system extremely suited for uncovering short term variations (minutes) in
metabolism. In summary, our systems for respirometry are developed for prolonged and
automatic measurements of oxygen consumption rate in a controlled laboratory environment.
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DAQ-4 instrument

FLUSH RECIRC O0O2/N2 TEMP 100-240VAC

Recirc pump

Respirometer

Flush pump —

Screen 23 shows how to connect the flush and the recirc pump to the respirometer by tubes.
The connection to the DAQ-4 instrument (dotted lines) is described above.

Page 24 of 55



LOLIGOSYSTEMS.COM

5.Using AutoResp™ 4
5.1 Startup

e Click on the AutoResp™ 4 icon in the Start menu by following the folder hierarchy
shown on Screen 24.

Screen 24

il MNew Office Document. LoliResp
] newshorteut2 Microsoft Access

@ Open Office Document Microsoft Excel

@ SetProgram Access and Defaults Microsoft FrontPage
% Windows Catalog Microsoft Outlook
“ Windaws Update Micrasoft PowerPaint
D winZip Microsoft Ward
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@ Acer ePM

@ Acer Gridvista

@ AcerSystem

] IE@ Antivir PersonalEdition Classic

o Remote Assistance

& windows Media Player

a Windows Movie Maker

) QuickTime ’
&‘, Windows Live Messenger

[ wisu+EY »
@ LolTRACK »
@ Canon Utilites

@ €350 - Multi-Channel Gas Exchange Software
é Internet @ CyberLink PowerlvD

Internet Explorer @

Eltima Software

E-mail G
Pt cutoc || @ S
@ LABTECH NOTEBOCKpro Version 12,1
@ Quattro Track @ Launich Manager

@ Measurement Computing

@ LoliTRACK I Microsoft Office Todls

IE@ National Instruments

Microsoft Excel

bl @ NTI Backup NOW/! 4

" IF) NTICD &.DVD-Maker 7
AutoRespE4

@ Philips SPC S00NC PC Camera

@ Mezsurement & Au @ Philips ToUcam Camera

I Pinnacle PCTV USB2

w Paint I REALTEK Gigabit and Fast Ethernet NIC Driver
@ Startup

I verrier Software

@ winzip

8 Adobe Reader 7.0

AutoResp4

\Program Files\AutoResp4

i

Microsoft }‘ ’
Windows

Home Edition

r v ¥y v v v ¥ v ¥ v ow v w oy wow ww woww w w

@XEREE D Ena Bl satam

# Internet Explorer

e If the USB hardware protection dongle is not connected to the PC, an error dialog
box pops up, see Screen 25.

Screen 25

‘AutoResp4.exe: Start Error ﬂ
g Copy protection error: Mo license found, 2539: 100000,

Retry Cancel

e Connect the USB hardware protection dongle to the PC via an USB port and click on
Retry. Screen 26 now becomes present.
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P AutoResp™ 4
File  Edit View  Help

LOLIGOSYSTEMS.COM

e When AutoResp™ 4 has started properly click on the File menu > New experiment.
Screen 27 is now present.
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5.2 Calibration and selection of oxygen input

5.2.1. General about Screen 27

Screen 27 is the calibration screen as it looks if chamber oxygen input is a 0-5
VDC analog signal, e.g. from an OXY-REG or some other O, instrument. On this
screen a common sample frequency for all inputs can be chosen, and the inputs
can be calibrated from voltages into oxygen partial pressures and temperature.
This screen can also be used to do a quick oxygen or temperature measurement.
Please note: The calibration values is not stored until an experiment has been
started. That means the calibration values are NOT stored when the Next -->
button is pressed.

Screen 27
s AEE
| File Help
Sample frequency Barometic pressure (hPa) pO: st (kPa) Fiber Optic OFF Set temp (503
the < o 1013 20,859 - | 20,00
Chamber oxygen 1 Chamber oxygen 2 Oxygen graph kPa

12,16
kPa L
Mav Avig Tnput (43 pOz (kPa) Maow Avig Tnpuk (43 ROz (kPa) S O i ¥

i - 115,66
1 point T ] 2,92 12,23 1 point - l 13,75 115,71 25— "
|16,37
L input (%) : L@ input 3] L poa (kPa) 17’03
Lock LG “Hlo,00 o, Lockto | o0 #Jlo,00 22,5 -
113,
HIinput I3 HIpO: (kPa) HI input () HI pi: (kPa)
Lack HT o)ls,00 20,9 Lockhr | 7Jis.00 t)l20,96
Chamber oxygen 3 . Chamber oxygen 4 17,5~
Mow Awvg Input () Pz [kPa) Moy Avg Input (%) pQ: (kPa)

1 point TI 3,92 16',4'2 1 point = 4,07 17,07

L0 input () LO pO: (kPa) LOinput (¥} Lo iz (kPa) =
LockLO ofj0,00 210,00 LockLO 40,00 20,00 2125
v, Y

HI input {43 HIpC: (kPa) HI inp_ut (L] _HIPO_; (kPay

Lack HI oI5, 00 20,9 Lack HI iis,00 20,9
b, v, 7, 7

Ambient oxygen ] Temperature . 7,5

LE L

Moy Avg Input (¥} p: (kPa) Mo Awg Input (¥} Temp (*C)
1 poink - ] 3,16 13,27 1 point <~ 13,34 66,76
L@ input L5 LO po: (kPa) LG input 1 LG Temp (°C) e
'j 0,00 10,00 Lock L) 210,00 Hilo,00 :
N V) )
_HEinput ) HIpO: (kPa) HI input (3] HI Temp (°C) o-

Lack HI 'J,' 5,00 20,06 Lock HI s, 100,00 10:34:45 10:35:45
E A7 Y v

Time

pEl
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5.2.2. Sample frequency button

Use this button to set a common sample frequency for all inputs. The frequency
can be set from one sample to ten samples per second.
Please note: All inputs are always sampled at the same rate.

5.2.3. Barometic pressure (hPa)

Use this button to set the days actual barometic pressure in hPa. This field is
used only in fiber optic measurements, and is disabled/enabled together with the
fiber optic button status OFF/ON. The default value is 1013 = 1 atm =760
mmHg.

5.2.4, pO2 sat. (kPa)

Use this button to set the saturated partial pressure of oxygen in kPa, see 8.1
pO2 kPa table on page 50. This field is needed to convert the oxygen values in
kPa to %air sat. and %oxygen sat. via the Unit button, see 5.2.11.2 Unit button
on page 34. The default value is 20,859 which corresponds to 1013 kPa at 15
°C.

5.2.5. Fiber optic button

Use this button to select the type of oxygen input. When the button displays
“Fiber optic off”, chamber oxygen input should be 0-5 VDC, e.g. from OXY-REG
instrument. When the button displays “Fiber optic on”, the chamber oxygen
input is acquired via the PreSens fiber optic instrument and the RS232 port of
the PC. Pressing the button toggles Screen 27 and Screen 29 seen on page 35.
Before proceeding to “Fiber Optic on” the user is prompted to choose the COM
port the fiber optic instruments from PreSens is connected too.

Please note: When fiber optic is on, as seen on Screen 29 on page 35, the
sample frequency cannot be altered as it is predetermined by the fiber optic
instrument from PreSens. The frequency is approx. 1 Hz when reading 1 channel
and 2 Hz when reading all 4 channels.

5.2.6. Set temp (°C)

Use this button to set the temperature of the ambient water in °C. This field is
used only in fiber optic measurements, and is disabled/enabled together with the
fiber optic button status OFF/ON. The default value is 20 °C.

If the temperature cannot be kept during measurements within the entered
value with £0,2 °C, choose to compensate the fiber optic oxygen signal with the
measured temperature signal by enable the checkmark Analog Comp, see
5.2.14.1, page 37. If Analog Comp is enabled, the Set temp (°C) field gets
disabled and will be updated with the measured temperature. The fiber optic
oxygen value will now be real-time compensated for the temperature.
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5.2.7. Next --> button

Screen 28

Use this button to accept the calibration settings and move on to setting up a
resp. experiment see 5.2.14, page 37. Before proceeding to the setup the user
is prompted to enter a data file name and path, see Screen 28. The path
specifies the location of the main data file and a folder containing raw data files
from the experiment. The path is by default the installation directory of
AutoResp4\AutoResp4Data. The current time and date.xls is suggested as a
filename in the prompt. Both the path and filename can be altered by choice.
The system suggests two file extensions .xls and .txt. The .xls extension will
create a tabulator separated text file which is readable by Microsoft ® Excel. The
.txt extension will create a semicolon separated text file which is readable by
any Microsoft ® Windows PC.

In addition to the data file the system will also generate a folder named as the
data file. The dot (.) in the filename will however be replaced by an underscore
(L) in the folder name. In this folder files containing raw data will be generated
for each measurement loop. The raw data files contain data from the measure
period on which the calculated values in the main data file are based.

Save data file as. EIE‘
Gemi | 3 AutcResptData ~ o#erm-
Seneste
dokumenter
;-1%.
Skrivebord
Dokumentst
|
58
Denne computer
‘,; Fihavn v 0K
. 1
Metvzerkssteder | Filtype: | Excel compatible or ; delimited text file (“xks"bx v | Annuller
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5.2.8. Chamber oxygen field 1-4
5.2.8.1. Mov Avg button

Use this button to select if the chamber oxygen input signal should be averaged
or not. The default value is 1 point which means no averaging of the input. If
any other value is chosen the chamber oxygen input will be averaged and the
averaged values will be used for all subsequent computations, screen and file
outputs. Use moving average if you wish to “smoothen” the chamber oxygen
signal.

Please note: No calibrated values will be displayed either on screen or in the
data file before sufficient samples have been collected to compute the moving
average. E.g. if the moving average is set to 30 points and the sample rate is
set to 10 Hz there will be no chamber oxygen values the first 30 samples
equivalent to the first three seconds of samples.

5.2.8.2. Input (V) indicator
This field displays the actual voltage input.

5.2.8.3. pO, (kPa) indicator

This field displays the actual calculated oxygen partial pressure from the voltage
input.

5.2.8.4. Lock LO button

This button can be used to copy the actual value from the Input (V) indicator to
the LO input (V) field instead of manually reading and retyping the value.

5.2.8.5. LO input (V)

Use this field to enter the low input voltage from the Input (V) indicator during
the chamber oxygen calibration.
Please note: The field is limited to values between 0V to 5V

5.2.8.6. LO pO, (kPa)

Use this field to enter the oxygen pressure during the low level oxygen
calibration of the chamber oxygen input.
Please note: The field is limited to values between 0.00 kPa to 60.00 kPa

5.2.8.7. Lock HI button

This button can be used to copy the actual value from the Input (V) indicator to
the HI input (V) field instead of manually reading and retyping the value.
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Use this field to enter the high input voltage from the Input (V) indicator during
the chamber oxygen calibration.
Please note: The field is limited to values between 0V to 5V

5.2.8.9. HI pO, (kPa)

Use this field to enter the oxygen pressure during the high level oxygen
calibration of the chamber oxygen input.
Please note: The field is limited to values between 0.00 kPa to 60.00 kPa

5.2.9. Ambient oxygen field
5.2.9.1. Mov Avg button

Use this button to select if the ambient oxygen input signal should be averaged
or not. The default value is 1 point which means no averaging of the input. If
any other value is chosen the ambient oxygen input will be averaged and the
averaged values will be used for all subsequent computations, screen and file
outputs. Use moving average if you wish to “smoothen” the ambient oxygen
signal.

Please note: No calibrated values will be displayed either on screen or in the
data file before sufficient samples have been collected to compute the moving
average. E.g. if the moving average is set to 30 points and the sample rate is
set to 10 Hz there will be no ambient oxygen values the first 30 samples
equivalent to the first three seconds of samples.

5.2.9.2. Input (V) indicator
This field displays the actual voltage input.

5.2.9.3. pO, (kPa) indicator

This field displays the actual calculated oxygen partial pressure from the voltage
input.

5.2.9.4. Lock LO button

This button can be used to copy the actual value from the Input (V) indicator to
the LO input (V) field instead of manually reading and retyping the value.

5.2.9.5. LO input (V)

Use this field to enter the low input voltage from the Input (V) indicator during
the ambient oxygen calibration.
Please note: The field is limited to values between 0V to 5V
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Use this field to enter the oxygen pressure during the low level oxygen
calibration of the ambient oxygen input.
Please note: The field is limited to values between 0.00 kPa to 60.00 kPa

5.2.9.7. Lock HI button

This button can be used to copy the actual value from the Input (V) indicator to
the HI input (V) field instead of manually reading and retyping the value.

5.2.9.8. HI input (V)

Use this field to enter the high input voltage from the Input (V) indicator during
the ambient oxygen calibration. The lower Lock button can be used to copy the
actual value from the Input (V) indicator to the HI input (V) field instead of
manually reading and retyping the value.

Please note: The field is limited to values between 0V to 5V

5.2.9.9. HI pO, (kPa)

Use this field to enter the oxygen pressure during the high level oxygen
calibration of the ambient oxygen input.
Please note: The field is limited to values between 0.00 kPa to 60.00 kPa

5.2.10. Temperature field
5.2.10.1. Mov Avg button

Use this button to select if the temperature input signal should be averaged or
not. The default value is 1 point which means no averaging of the input. If any
other value is chosen the temperature input will be averaged and the averaged
values will be used for all subsequent computations, screen and file outputs. Use
moving average if you wish to “smoothen” the temperature signal.

Please note: No calibrated values will be displayed either on screen or in the
data file before sufficient samples have been collected to compute the moving
average. E.g. if the moving average is set to 30 points and the sample rate is
set to 10 Hz there will be temperature values the first 30 samples equivalent to
the first three seconds of samples.

5.2.10.2. Input (V) indicator
This field displays the actual voltage input.

5.2.10.3. Temp (°C) indicator

This field displays the actual calculated temperature from the voltage input.
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This button can be used to copy the actual value from the Input (V) indicator to
the LO input (V) field instead of manually reading and retyping the value.

5.2.10.5. LO input (V)

Use this field to enter the low input voltage from the Input (V) indicator during
the low temperature calibration.
Please note: The field is limited to values between 0V to 5V.

5.2.10.6. LO Temp (°C)

Use this field to enter the temperature during the low temperature calibration.
Please note: The field is limited to values between 0 °C to 100 °C.

5.2.10.7. Lock HI button

This button can be used to copy the actual value from the Input (V) indicator to
the HI input (V) field instead of manually reading and retyping the value.

5.2.10.8. HI input (V)

Use this field to enter the high input voltage from the Input (V) indicator during
the high temperature calibration.
Please note: The field is limited to values between 0V to 5V.

5.2.10.9. HI Temp (°C)

Use this field to enter the temperature during the high temperature calibration.
Please note: The field is limited to values between 0 °C to 100 °C.
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5.2.11. Chamber Oxygen graph field

This graph shows the oxygen pressure vs. time measured for the 4 chambers
going back 1 min. By right clicking the graph it is possible to show/hide the
output data from a chamber. It is also possible to show/hide the ambient
oxygen. This is only possible if the Play button is ON. When OFF and right
clicking it is possible to copy data and export a simplified image of the graph.
Right to the graph there are six fields, where current data are shown. The first
field shows the chosen units, which can be altered by the unit button.

It is possible to change the color for every signal by clicking on the color field for
every signal.

5.2.11.1. Save button

Use this button to save the data displayed in the Oxygen graph. Furthermore the
temperature will be saved. When pressed the user is prompted to enter a file
name and path, see Screen 28. The path is by default the installation directory
of AutoResp4\AutoResp4Data. The current time and date.xls is suggested as a
filename in the prompt. Both the path and filename can be altered by choice.
The system suggests two file extensions .xls and .txt. The .xls extension will
create a tabulator separated text file which is readable by Microsoft ® Excel. The
.txt extension will create a semicolon separated text file which is readable by
any Microsoft ® Windows PC.

5.2.11.2. Unit button

Use this button to convert the displayed oxygen partial pressure values on the
chamber oxygen graph into Torr, %oxygen saturation or %air saturation.

5.2.11.3. Play button

Use this button to start/stop data from being graphed. When the play button is
ON, new data will be shown on the oxygen graph and the Unit button is enabled.
When the play button is OFF, the Unit button is disabled. Furthermore a scroll
bar is shown for the chamber oxygen graph. The state of the Play button also
changes the menu of the Chamber oxygen graph, see 5.2.11, page 34.
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5.2.12. General about Screen 29

Screen 29 is the calibration screen as it looks if the chamber oxygen signal is
acquired from the OXY-4 OXY-4 mini instrument and the RS232 port of the PC.
Please note: When fiber optic is on, as seen on Screen 29, the sample
frequency cannot be altered as it is predetermined to approx. 1-2 Hz by the
OXY-4 mini instrument.

Please note: The look and functionality of the Ambient Oxygen field and the
Oxygen graph field are similar to those of Screen 27.

Screen 29
A AutoResp™ 4
File Help
Sample frequency Barome\t‘ic pressure (hPa) pC‘)z .sat. (kPa)l Fiber Optic ON Set temp (=)
i o A - - o
Chamber oxygen 1 [ |Enable Chamber oxygen 2 [ |Enable Dxygen graph kPa
10,51
kPa gt
Moy Avg po:z (kPa) Mov Avg Pz (kPa) O 4\_1 fe=
1paint l 10,58 1paint - ‘ 14,22 25+ o
L Temp (°C)  Phase (%) LO Temp (*C)  Phase ()
HI Temp (°C) Amplitude HI Temp (2C) Amplitude
Chamber oxygen 3 [ JEnable B | Chamber oxygen 4 [JEnable 17,5+
Mov Awg s (kPa) Moy Avg EOz"(lﬁPa)
1 point T] 515.,0.0 ¥ 1 point T l 115,73 15-
Lo Temp >C)  Phase () L Temp (2C) Phase (%} o
Lock LD ;) 20,00 0 Laock LO _:JJ.ZD,DU a % 12,5
HI Temp (*C)  Amplitude HI Temp {2C) Arnplitude
4 25 i e ' 10-
Lock HI ’,) 20,00 0 Lock HI _L}J 20,00 o
Ambient oxygen | | Temperature [ |Analog Comp . 7.5
Mov Avg Input (¥} p: (kPa) Moy Avg Input () Temp (7C)
1 poink - l 2,78 111,64 1 poink ! 7,96 159,15
L input (W) L0 po: (kPa) LO input £} LO Temp £°C) ae
Lack LD ’/J 0,00 \ij},n,oo Lack LD \ij},u,oo ’LJ_D,UD
_HIinput (¥} HI pOz (kPa) HIinput () HI Temp (°C} -} |
Lack HI :/]-s,uo 20,96 Lack HI 5,00 100,00 10:39:23 10:40:23
' - - - Time
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5.2.13. Chamber oxygen field 1-4

5.2.13.1. Mov Avg button

Use this button to select if the chamber oxygen input signal should be averaged
or not. The default value is 1 point which means no averaging of the input. If
any other value is chosen the chamber oxygen input will be averaged and the
averaged values will be used for all subsequent computations, screen and file
outputs. Use moving average if you wish to “smoothen” the chamber oxygen
signal.

Please note: No calibrated values will be displayed either on screen or in the
data file before sufficient samples have been collected to compute the moving
average. E.g. if the moving average is set to 10 points and all four channels are
enabled there will be no chamber oxygen values the first ten samples equivalent
to the first twenty seconds of samples.

5.2.13.2. Enable channel

By clicking on this field, the channel gets enabled, and oxygen data will be
received.

Please note: It is only possible to enable a channel, when a sensor is connected
to the OXY-4 mini instrument.

Please note: If a sensor is not used, then disable the channel. This will increase

the lifetime of the sensor.

5.2.13.3. pO, (kPa) indicator

This field displays the chamber oxygen pressure from the OXY-4 fiber optic
instrument from PreSens relative the calibration.

5.2.13.4. Lock LO button

Press this button to calibrate the OXY-4 mini instrument in a 0% air saturation
0, sample.

Please note: It is important not to push the Lock LO button before the Phase
(°) and Amplitude indicators has stabilized.

Please note: A full calibration must consist of a 0% calibration and a 100%
calibration before the oxygen readouts are reliable.

Please note: The calibration will be written down on an EEPROM in the OXY-4
mini instrument. If you want to use the OXY-4 mini instrument with the software
from PreSens a new calibration may be done using this software.

5.2.13.5. LO Temp (°C)

Use this field to specify the temperature during calibration of the OXY-4 fiber
optic instrument with the 0% air saturation O, solution.
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5.2.13.6. Lock HI button

Press this button to calibrate the OXY-4 mini instrument in a 100% air saturation
0, sample.

Please note: It is important not to push the Lock HI button before the Phase
(°) and Amplitude indicators has stabilized.

Please note: A full calibration must consist of a 0% calibration and a 100%
calibration before the oxygen readouts are reliable.

Please note: The calibration will be written down on an EEPROM in the OXY-4
mini instrument. If you want to use the OXY-4 mini instrument with the software
from PreSens a new calibration may be done using this software.

5.2.13.7. HI Temp (°C)

Use this field to specify the temperature during calibration of the OXY-4 fiber
optic instrument with the 100% air saturation O, solution.

5.2.13.8. Phase (°) indicator

This field indicates the phase angle of the optical signal that the OXY-4 mini
instrument uses for computations of the chamber oxygen pressure. For further
information about the OXY-4 mini instrument see 8.6 OXY-4 Instruction manual,
page 55

5.2.13.9. Amplitude indicator

This field indicates the amplitude of the optical signal that the OXY-4 mini
instrument measures. The signal strength is an indicator for the sensor
condition. See the manual of the OXY-4 fiber optic instrument from PreSens for
further explanation.

5.2.14. Temperature field

When the fiber optic button is ON, the Temperature field gets changed from
Screen 27 page 27, to Screen 29 page 35. A checkmark appears named Analog
Comp.

5.2.14.1. Analog Comp

Use this checkmark to enable/disable the real-time compensation of the fiber
optic oxygen signal with the analog measured temperature. If the temperature
changes with 0,2 °C, the new temperature will be send to the fiber optic
instrument.
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5.3 Setup experiment

5.3.1. General about Screen 30
On Screen 30 the intermittent respirometry experiment is configured.

Screen 30

B AutoResp™ 4

File Edf Yiew Help

5.3.2. File name button

Use this button to change the path and filename of the data file and raw data
folder. The path specifies the location of the main data file and the folder
containing raw data from the experiment. The path is by default the installation
directory of AutoResp4\AutoResp4Data. The current time and date.xls is
suggested as a filename in the prompt. Both the path and filename can be
altered by choice. The system suggests two file extensions .xls and .txt. The .xls
extension will create a tabulator separated text file which is readable by
Microsoft ® Excel. The .txt extension will create a semicolon separated text file
which is readable by any Microsoft ® Windows PC.

In addition to the data file the system will also generate a folder named as the
data file. The dot (.) in the filename will however be replaced by an underscore
(_) in the folder name. In this folder files containing raw data will be generated
for each measurement loop. The raw data files contain data from the measure
period on which the calculated values in the main data file are based.

Please note: The start experiment button will be disabled until a valid
path/filename is selected.
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5.3.3.1. Flush period (s)

Use this field to specify the duration of flush periods in seconds during the
intermittent flow respirometry experiment.
Please note: The field is limited to values between 0 s to 35 weeks.

5.3.3.2. Wait period (s)

Use this field to specify the duration of the wait periods in seconds during the
intermittent flow respirometry experiment.
Please note: The field is limited to values between 1 s to 35 weeks.

5.3.3.3. Measure period (s)

Use this field to specify the duration of the measure periods during the
intermittent flow respirometry experiment.
Please note: The field is limited to values between 1 s to 35 weeks.

5.3.3.4. O, solubility (mg 02/1/kPa)

Use this field to specify the oxygen solubility of sample water.

Please note: This field is limited to values between 0 to 0,75 mg/L/kPa. The
default value is 0,4855 corresponding to a 15°C fresh water. For further
information see the appendix, page 50 and 51

5.3.3.5. Note field

In this field the user can write a note about the experiment. The note is saved to
the data file.
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5.3.4. Chamber field 1-4
5.3.4.1. Resp vol. (1)

Use this field to specify the volume of water used for the calculation of the MO,
value.

Resp vol. = chamber volume + tube volume - volume of organism(s)

To specify the Resp vol., fill the chamber and the tubes with water and measure
the weight on a scale. Now empty the chamber and the tubes for water and
measure the weight again. The difference between the two measurements will
be the weight of the chamber volume and the tube volume. Multiply the
calculated weight with the mass specific volume of water for finding the volume
for the chamber and the tubes.

To find the volume of the organism measure the weight of the organism and
multiply with the mass specific volume of the organism.

Please note: This field is limited to values between 0 to 2500 I.

5.3.4.2. Wet weight (g)

Use this field to specify the weight of the experimental organism(s).
Please note: This field is limited to values between 0,001g to 100 kg

5.3.5. Oxygen control field
5.3.5.1. Checkbox

Use the checkbox to enable or disable the O,/N; relay on the DAQ-4 instrument.
If the checkbox is checked AutoResp™ 4 can control the O, pressure in the
ambient water as specified in the oxygen control field.

5.3.5.2. Setpoint (kPa)

Use this field to set an oxygen level in the ambient water that the system should
maintain during an experiment.
Please note: The field is limited to values between 0 kPa to 60 kPa.

5.3.5.3. Hysteresis (kPa)

Use this field to change the oxygen hysteresis value. Use a hysteresis value > 0
kPa to ensure that the O,/N, valve does not flicker on the sharp edge of the
setpoint. If the hysteresis pressure is 0 kPa the O,/N, valve is very susceptible
to electronic noise on the ambient oxygen channel.

Please note: The field is limited to values between 0 kPa to 30 kPa.

5.3.5.4. Hypoxic/Hyperoxic

Use these buttons to select if the system must maintain the setpoint as a
maximum (Hypoxic) or a minimum (Hyperoxic) oxygen pressure.

Page 40 of 55



LOLIGOSYSTEMS.COM

5.3.6. Temperature control field

5.3.6.1. Checkbox

Use the checkbox to enable or disable the TEMP relay on the DAQ-4 instrument.
If the checkbox is checked AutoResp™ 4 can control the temperature in the
ambient water as specified in the temperature control field.

5.3.6.2. Setpoint (°C)

Use this field to set a temperature level in the ambient water that the system
should maintain during an experiment.
Please note: The field is limited to values between -2 °C to 100 °C.

5.3.6.3. Hysteresis (°C)

Use this field to change the temperature hysteresis value. Use a hysteresis value
> 0 °C to ensure that the cooler/heater pump does not flicker on the sharp edge
of the setpoint.

If the hysteresis temperature = 0 °C the cooler/heater pump is very susceptible
to electronic noise on the temperature channel.

Please note: The field is limited to values between 0 °C to 49,99 °C.

5.3.6.4. Cool/Heat

Use these buttons to select if the system must maintain the setpoint as a
maximum (Cool) or a minimum (Heat) temperature.

5.3.7. Start experiment button

Use this button to accept the setup settings as they are displayed on Screen 30
and proceed to Screen 31.

5.3.8. Menus in Screen 27, Screen 29 and Screen 30

5.3.8.1. File > Exit

Exits AutoResp™ 4 without saving changes to the calibration screens.

5.3.8.2. File > Continue experiment

Continues the last experiment, if stopped by user. Data on the graphs will only
be in memory, when AutoResp™ 4 has not been shut down.

Please note: This option is only available if a calibration has been made and the
user has stopped a running experiment.

5.3.8.3. Help > About

Displays contact information about Loligo Systems.
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5.4 Running experiment

5.4.1. General about Screen 30

On Screen 31 the intermittent respirometry experiment is running.

Screen 31
Ag AutoResp™ 4

LOLIGOSYSTEMS.COM

File Edit View Help

24—
22,5- Status
20— Remaining time {s)
17,51 113 ) FLUSH
£ Stat
E 15 ate
= b |F5 & RECIRC
o
=
H
= Chamber 1
Oz (kPa) MOz R2
10,51 MaN |Nan
Chamber 2
........... Oz (kPa)  MO: Rz
11:04:23 11:14:23 14,16 MaN  NaM
Tirne
100~
Chamber 3 o (P MO: na
[ ] 14,94  |MaM |MaN
5} Chamber 4
= O:(kPa)  MO: Rz
5 |15,65  |Mah |Mahi
Z
£
5 5
(5] Ambient 02 Ga)
E @ ozinz 11,58
— Apteen: taopemenze Temp (°C)
11:04:23 11:14:23 | | @ e 53,85
Time
5.4.2. Oxygen graph field

This field shows the measured oxygen values vs. time. By right clicking the
graph, the user can choose which chamber graph is to be shown. It is also
possible to show the ambient oxygen as a graph and modify the time interval on
the x scale (10, 30 and 90 min). Another option is to save the graph to a file and

to show the experiment settings.
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5.4.3. Graph field

This field shows some different graphs for the experiment. As default the current
temperature vs. time graph is shown. The user can choose between the
following graphs by clicking with the mouse on the view button in the menu.

MO, vs. time

MO, vs. avg. Chamber O,
Avg. temperature vs. time
Current temperature vs. time
R? vs. time

Current R? vs. time

The MO,, avg. temperature and the R? vs. time graph shows data from the
whole experiment. The current temperature and the current R? vs. time graph
shows data for the last 10, 30 or 90 min, depended on the x scale from the
oxygen graph, see 5.4.2. By right clicking on the graph, the user can save the
shown graph to a file.

5.4.4. Status field

5.4.4.1. Loop remaining (s)

This field shows the remaining seconds left of the current measurement loop.
The loop is defined as the summed duration of flush, wait and measure periods.

5.4.4.2. Loop number (s)

This field shows the actual state of the loop and the number of loops. The letter
F means flush, W means wait and M means measure. Behind the letter a number
is shown, which shows the actual humber of the loop.

5.4.4.3. Flush indicator

This diode indicates if the flush pump is activated or not. The flush pump is
running only in a flush period.

5.4.4.4. Recirc indicator

This diode indicates if the recirculation pump is activated or not. The
recirculation pump is running in a flush and a measure period.
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5.4.5. Ambient measure field

5.4.5.1. Ambient O, (kPa)

This field shows the actual measured ambient water oxygen pressure.

5.4.5.2. Temperature (°C)

This field shows the actual measured temperature.

5.4.5.3. Oxygen regulation

This field shows if the oxygen regulator is working to maintain the oxygen level
in the ambient tank as hypoxic or hyperoxic, see 5.3.5 Oxygen control field,
page 40.

5.4.5.4. Temperature regulation

This field shows if the temperature regulator is working to maintain the
temperature level in the ambient water, see 5.3.6 Temperature control field,
page 41.

5.4.6. Chamber measure field 1-4

5.4.6.1. Chamber O, (kPa)

This field shows the actual measured oxygen pressure for the chamber.

5.4.6.2. MO, field

This field shows the calculated MO, value for the chamber as described in
background, see 4 Introduction to intermittent flow respirometry, page 21. The
MO, value is calculated as follows:

mgO, .. [ mgo, e{kPa} 1000 4
MO = 3600 O, solubility| ——2 |- dope — |- respvol ]| |- —————
Z{h-kg} ? ”"yL-kP s T J o]

a wet weight

Where slope is calculated as follows:

slope[ kPa} _ 9= O
s | time, —time, ,

Please note: MO, is only calculated in each measurement period, e.g. 29 MO,
values after 30 seconds measure period at 1 Hz.
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This field shows the calculated R? linear correlation coefficient value for the
chamber when MO, is calculated. The R? value can be used to validate the linear
fit of the O, curve.

5.4.7. Menus in Screen 31

5.4.7.1. File > Stop experiment

This option stops the current experiment.
Please note: To immediately turn on the flush pump use this option.

5.4.7.2. Edit > Oxygen

While the experiment is running the user can use this option to alter the oxygen
regulation. This can be done by changing the setpoint, the hysteresis or the
mode hypoxic/hyperoxic.

5.4.7.3. Edit > Temperature

While the experiment is running the user can use this option to alter the
temperature regulation. This can be done by changing the setpoint, the
hysteresis or the mode cool/heat.

5.4.7.4. View

By this option the user decides which graph is to be shown in the graph field,
see 5.4.3 Graph field on page 43.

5.4.7.5. Help > About

Displays contact information about Loligo Systems
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6.Troubleshooting

6.1 No connection to the DAQ-4 instrument

Screen 32

0 Error -201003 occurred at DAQmx Create

Channel {DO-Digital Output}.vi:1

|Possible reason(s): s

Measurements: Device cannok be accessed, Paossible
Causes:

Device is no longer present in the syskem.

Device is nok powered.

Device is powered, buk was temporarily without power,
Device is damaged,

Ensure the device is properly connected and powered. ‘
Turn the computer off and on again, IF wou suspect that

[th dewice iz darmaned conback Blational Tnckeorente s

The error shown on Screen 32 occurs, when the NI-USB 6215 DAQ card has no
properly connection to the PC. This error can occur in 2 ways.

6.1.1. Name is not "Devl1l”

To change the device name, open Measurement & Automation by following the
folder hierarchy shown on Screen 21, page 16. The following example shows on
Screen 33 a simulated device named as “"Dev1”. The NI-USB 6215 DAQ card is
registered as “Dev2”

Page 46 of 55



Screen 33

I_OLIGO
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D NI USB-6215: "Dev1” - Measurement & Automation Explorer

mEX]

File Edit view Tools Help

Configuration

A| & Properies | X Delete | [fhself-Test | % TestPanek...

= @ My System
=3 Data Neighborhood
1=-@@ Devices and Interfaces
= (@ MI-DAQMx Devices
~p8 NIUSB-6215: Devl”
- NIUSE-6215: Dev2’
@ PX1 PXI System (Unidentified)
i@ Scales
@@ Software
¥ Remote Systems

43 Reset Deviee

(i create Task. .

MName
[l serial rumber

Value
0x0

@ Configure TEDS... | ** [, Hide Heb |
eack faz
NI-
DAGmx Device
Basics

What do you want
to do?

<+ Bun the MNIFDAQHMmx
Test Panels

+ Bemove the
device

+ Yiew or change
device propeties

I Attibutes | @ Device Routes | 4] Calioration

=l

| 3]

mﬂ ¥ screen 18.bmp - Paint ]['@musaﬁms: Devi.. |

'@¥@!2§’I @ %l o53am

Right click with mouse on the “"Dev1”, and choose rename, or press F2. Change
the name to something different than “"Dev1”. In this example the name is
changed to “devlsimu”, see Screen 34.

Screen 34

| NIUSB-6215: "Devisimu” - Measurement & Automation Explarer

BE) %]

Fle Edt View Tools Help

Configuration K| @ Popertes | X Delete | [EhseifTest | 9B TestPanels.. | ‘D ResetDeviee | (M CresteTask.. @ Configure TEDS.. ™ |, Hide Help |
= & My System
© {8 Data Neighborhood MName Value Blpack _EJA‘
| = B9 Devices and Tnterfaces Dserial tumser 00
H = (B8 NI-DAGMx Devices NI-

| ifUSEEaIs DTS DAGmMx Device

| Ly NIUSB-6215: Dev2” Basics

[ PX1 PXI System (Unidentified)

& Scales
| @ (@ Software
- ) Remote Systems

What do you want
to do?

<+ Bun the NEDAQr:x
TestFanels

++ Remaove the
device

< ¥iew or change
device properies

LY Attibutes [ @ Devics Routes | 4] Calibration

[€] I

NEY

screen 19.bmp - Paint

Q ‘NIUSE-6215: Dev

OXERENEYAO Bl ssam
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Now change the device name of the NI USB-6215 DAQ card to “"Devl”. The
DAQ-4 instrument should now work properly with AutoResp™ 4.

Screen 35
|@ NI'USB-6215: "Dev1" - Measurement & Automation Explorer
File Edit view Tools Help
Configuration QJ B Properties | X Delete | [ Self-Test TestPanels... | %3 ResetDevice | {Mi Create Task... | W& Configure TEDS. .
=] 9 My System =
teighbarhocd Name yalue E3Back

s oric TR Fices | Y serial Number ONE659F2
I-DAQM Devices NI-

1 NI LUSB-6215: "Devisimu’ DAOGmMX Device
8 NIUSE-6215: Devi” Basics
@ PX1 PXI System (Unidentified)
-8 scales
B Sefware

¥ Remote Systems What do you want

to do?

<+ Bun the MNIFDAQHMmx
Test Panels

+ Bemove the
device

+ Yiew or change
device propeties

E Atributes } g Device Routes I k] Cal\blaﬂonJ &l m | [

M | ¥ sereen 20.bmp - Paint

OXEWIIEGAD B, ssan

Please note: By changing the NI USB-6215 device to “devl” another
applications using devices from National Instruments might not work properly
anymore.

6.1.2. Another USB device was improperly removed

If an USB device, like a USB memory stick, is not properly removed, while
AutoResp™ 4 is running, there can be a connection problem with the DAQ-4
instrument. To solve this problem, close AutoResp™ 4. Then disconnect the USB
cable between the PC and the DAQ-4 instrument. Wait 30 seconds. Then connect
the cable and wait. When the green diode on the front side of the DAQ-4
instrument is flashing, the connection is re-established. Choose Continue
experiment to avoid loosing data.

6.2 Relays are not working

Make sure the DAQ-4 instrument is connected with a power cable, and the
Power button is ON.
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8.Appendix

pO> kPa table

8.1

File: PO2 kPa.xls

Partial pressure of oxygen (p02) at different

harometric pressures and temperatures = [ (Php-Pwvap)=.2094)

Temperature {(deg C) i] 2 4 A g 10 12 14 16 18 20 23 30 35 37 40

Pvap (kPa) 0,61 0,71 0,81 0,93 1,07 1,23 1,40 1,60 1,82 2,06 2,34 3,17 4,24 5,62 6,28 7,38

Pbp (kPa)
97,32| 20,256 20,237 20,215| 20,191 20,163] 20,132| 20,097 20,058) 20,013| 19,964) 19,909| 19,742| 19,526| 19,248| 19,117| 18,895
97,59 20,312| 20,292 20,271| 20,246| 20,218| 20,187| 20,152| 20,113) 20,068| 20,019 19,963| 19,796| 19,579 19,301| 19,169 18,947
97,85| 20,367 20,348 20,326| 20,302| 20,274| 20,242| 20,207| 20,167) 20,123| 20,073) 20,018| 19,850] 19,633) 19,353| 19,221| 18,999
98,12| 20,423| 20,403| 20,382| 20,357| 20,329 20,298| 20,262| 20,222 20,178| 20,128) 20,072| 19,904| 19,686) 19,406| 19,274| 19,050
98,39| 20.4758| 20.459| 20,437| 20.412| 20,.384| 20,353| 20.317| 20,277 20,233| 20,.183) 20,127| 19,958| 19,739] 19,459| 19,326| 19,102
98,65 20.534| 20,514| 20,492| 20.467| 20,439) 20,408) 20.372| 20,332) 20,288| 20.237) 20,182| 20,012) 19.,793) 19,512| 19,378| 19,154
948,92] 20,589 20,570 20,548| 20,523 20,495) 20,463 20,427 20,387) 20,342| 20,292) 20,236| 20,066| 19,046 19,564| 19,431) 19,206
99,19 20,645|] 20,625 20,603| 20,578 20,550) 20,518 20,482) 20,442) 20,397| 20,347 20,291| 20,121) 19,900] 19,617| 19,483) 19,257
99,45| 20,700 20,681 20,658| 20,633| 20,605) 20,573| 20,537 20,497 20,452| 20,402) 20,345| 20,175| 19,953] 19,670 19,536| 19,309
99,72| 20,756| 20,736| 20,714| 20,689 20,660| 20,628| 20,593| 20,552 20,507| 20,456) 20,400| 20,229| 20,007 19,722| 19,588| 19,361
99,989| 20,811) 20,791 20,769| 20,744 20,716| 20,684| 20,.648| 20,607 20,562| 20,511) 20,454| 20,283| 20,060) 19,775| 19,640] 19,413
100,25| 20,866| 20,847| 20,825 20,799 20,771| 20,739| 20,703| 20,662 20,617| 20,566| 20,509| 20,337 20,114| 19,828| 19,693 19,464
i00,.52| 20,922| 20,902| 20,880( 20,855| 20,.826| 20,794| 20,758| 20,717| 20,671| 20,620| 20,563| 20,391| 20,167| 19,881| 19,745 19,516
100.79) 20,977| 20,958| 20,935] 20,910| 20.881] 20,849 20,813| 20,772 20,726 20,675| 20,618| 20,445 20,221| 19,933| 19,797( 19,568
101,05) 21,033 21,013] 20,991] 20,965| 20,937| 20,904| 20,8668| 20,827 20,7681 20,730| 20,672| 20,499 20,274| 19,986| 19,850( 19,620
101,32) 21,088] 21,069 21,046 21,021| 20,992] 20,959( 20,923| 20,882 20,836( 20,784| 20,727| 20,553 20,328| 20,039] 19,902] 19,672
101,59 21,144| 21,124 21,102( 21,076| 21,047| 21,015| 20,978| 20,937| 20,891( 20,839 20,782| 20,607 20,381| 20,092| 19,955] 19,723
101,85 21,199 21,180) 21,157 21,131| 21,102| 21,070f 21,033| 20,992 20,946| 20,894| 20,836| 20,661| 20,435 20,144| 20,007 19,775
102,12 21,255| 21,235| 21,212 21,187| 21,158 21,125| 21,088| 21,047 21,000 20,948 20,8%91| 20,715| 20,488 20,197| 20,059[ 19,827
102,39) 21,310| 21.290| 21,268 21,242 21,213| 21,180( 21,143| 21,102 21,055| 21,003| 20,945| 20,770| 20,542| 20,250| 20,112 19,879
102,65| 21,366| 21,346| 21,323 21,297| 21,268 21,235 21,198| 21,157| 21,110( 21,058 21,000| 20,824| 20,595 20,303| 20,164[ 19,930
102.92) 21,421| 21.401) 21,378 21,353| 21,323| 21,290( 21,253| 21,212 21,165( 21,113| 21,054| 20,878 20,649| 20,355| 20,216( 19,982
103,19) 21,477 21,457| 21,434| 21,408] 21,379] 21,346 21,308] 21,267 21,220( 21,167| 21,109| 20,932 20,702| 20,408| 20,269 20,034
103,45) 21,532| 21,512) 21,489] 21,463| 21,434] 21,401] 21,363| 21,321] 21,275] 21,222| 21,163| 20,986[ 20,756| 20,461| 20,321[ 20,086
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0.04238 0.00071

Oxzygen solubllity in my 02-/liter-kPa at From Gresn & Carrit (1967). J. Mar. Biol. 25; 140-147. 1 kPa = 7,501 mmHg
different temperatures and salinities
Salinity (o/oo) 0 2 4 10 12 14 15] 18] 20] 22 24 26 28 30 3z 34 36
Temperature (deg C)
0| 0.65976| 0,6878 0,6781] 0,6685| 0,6591| 0,.6498) 0,6406| 0.6316|0,6227|0,6139|0,6053(0,59:7|0,5883|0,5800(0,5719|0,5638|0,5559(0,5480(0,5403
1| 0,.6785) 0,6694| 0O,6500) 0,6509| 0,.5418| 0,6329| 0,6241| 0,6154|0,6065|0,5954|0,5900|0,5818[0,5737|0,5657|0,5579|0,5501|0,5424[0,5349|0,5274
2| 0.6608] 0,6517| 0,0428| 0,6339] 0,6252| 0.6l166) 0,6082 0,5998)0,5916|0,5834|0,5754(0,5675(0,5597|0,5520|0,5444|0,5369|0,5295(0,5223|0,5151
3| 0.6436| 0,6349| 0,623 0,.6178| 0,6094| 0,6011) 0,5929| 0,55849|0,5769|0,5691|0,5614|0,5537|0,5462|0,53858|0,5315|0,5243|0,5171(0,5101|0,5032
4| 0,.6272| 0,6188| 0,0104| 0,6022] 0,5942| 0,.5862) 0,5783| 0.5706|0,5629|0,5553|0,5479(0,5405(/0,5333|0,5261)0,5190(0,5121|0,5052(0,4984|0,4917
5| 0,6114| 0,6033| 0,5953| 0,5574| 0,5796| 0,5719) 0,5643| 0,5565|0,5494|0,5421|0,5349(0,5278|0,52058|0,5139|0,5071|0,5004|0,4937(0,4872|0,4807
6| 0,5963] 0,5885| 0,5808| 0.5731| 0,5656| 0,.5582) 0,5508| 0,5436|0,5365|0,5294|0,5225[0,5156(0.5089|0,5022|0,45956|0,4891|0,4827(0,4763[0.4701
7| 0,5818| 0,5743| 0,5668| 0,5595| 0,5522| 0,5450) 0,5379| 0,5310|0,5241|0,5172|0,5105(0,5039|0,4974|0,4909|0,45845|0,4782|0,4720(0,4659|0,4595
8| 0.5680] 0,5607| 0,5535| 0.5463| 0,5393| 0,.5324) 0,5255] 0,5188|0,5121|0,5055|0,4990({0,4926(0.45863|0.4800|0,4739|0,4678|0,4618(0,4558|0.,4500
9| 0,5547| 0,5476| 0,5406| 0,5338| 0,5270| 0,5203| 0,5136| 0,5071)0,5006|0,4943|0,48580(0,4818|0,4756|0,46596|0,4636|0,4577|0,4519(0,4461|0,4405
10| 0.5419) 0,5351| 0,52683] 0,5217| 0,5151| 0.5086) 0,5022| 0,.4959|0,4696|0,46834|0,4774(0,4713|0.4654|0.4595|0,4537|0,4460({0,4424(/0,43668(0.4313
11| 0,5297| 0,5231| 0,515 0,5101| O,5037| 0,4974) 0,4912| 0,4851|0,4790|0,4730|0,4671|0,4613|0,4555|0,445958|0,4442|0,4387|0,4332(0,42758|0,4224
12| 0,5179] 0,5115] 0,5052| 0,4989| 0,4925| 0.40867) 0,4806| 0.4747|0,46808|0,4630(0,4573(0,4516|0.4460/0.4405)0,4351|0,4297|0,4244(0,4191/0.4139
13| 0,5067| 0,5005| 0,4943| 0,4882| 0,45823| 0,4763) 0,4705| 0,.4647|0,4590|0,4534|0,4478(0,4423|0,4369|0,4315|/0,4262|0,4210|0,4158(0,4107|0,4057
14| 0.4959) 0,4898] 0,4839] 0,4760] 0,4721| 0.4664) 0,4607| 0,.4551|0,4496|0,4441|0,43687(0,4333[0.42681|0.4229)0,4177|0,4126|0,4076(0,4026|0,3977
15| 0,45855| 0,4796| 0,47358| 0,4681| O0,4624| 0,45658) 0,4513| 0,4459|0,4405|0,4352|0,4299(0,4247|0,4196|0,4145|0,4095|0,4046|0,3997(0,3948|0,3901
16| 0.4755] 0,4698] 0,4641] 0,4506| 0,4531] 0.4476) 0,4423| 0,.4370|/0,4317|0,4266(0,4214(0,4164|0.4114|0.4065|0,4016|0,3968|0,3920(0,3673|0,3827
17| 0,4659| 0,4603| 0,4549| 0,4494| 0,4441| 0,4355) 0,4336| 0,.4254|0,4233|0,4183|0,4133|0,4054|0,4035|/0,3957|0,3940|0,3893|0,3846(0,35800(0,3755
18| 0.4567| 0,4513| 0,4459| 0,4407| 0,4354| 0.4303) 0,4252| 0,.4202|0,4152|0,4103|0,4054(0,4006|0.3959|0,3912|0,368660|0,36820(0,3775(0,3730(0,3686
19| 0,44758| 0,4426| 0,4374| 0,4322| 0,4271| 0,4221) 0,4171| 0,4122|0,4074|0,4026|0,3979|0,3932|0,358586|0,35840|0,3795|0,3750|0,3706(0,3662|0,3619
20[ 0,4393| 0.4342| 0,4291] 0.4241) 0,4191] 0,4142| 0,4094| 0,4046|0,3999|0,3952(0,3906|0,36860)0,36815|0,3770(0,3726(0,3603|0,3640)0,3587|0,3555
uVl 21| 0,4311| 0,4261| 0,4212| 0,4163| 0,4114| 0,4066| 0,4019| 0,3972|0,3926|0,3850({0,3535|/0,3791|0,3747|0,3703|0,3660(0,3617|0,3575|0,3534|0,3493
nwu 22| 0,4233| 0.4164| 0,4135] 0,.4087| 0,4040[ 0,3993] 0,3947| 0,3901|0,36856|0,3812(0,3767|0,3724|/0,3681|0,3638|0,3596(0,3554|0,3513|0,3473|0,3432
—y 23| 0,4157| 0,4109| 0,4062| 0,4015) 0,3969| 0,3923| 0,3578| 0,3833|0,3789|0,3745(0,3702|0,3659|0,3617|0,3575|0,3534(0,3494|0,3453|0,3413|0,3374
"= 24| 0.4084| 0.4037| 0,3991] 0.3945| 0,3900| 0,.3855| 0.3811| 0,3767|0,3724|0,3681(0,3639|0,3597|0,3556|0,3515|0,3475[0,3435|/0,3395|0,3356|0,3318
.hU 25| 0,.4014| 0,3968| 0,3923| 0,358758| 0,3833| 0,37590| 0,3746| 0,3703|0,3661|0,3619(0,35758|0,3537|0,3497|0,3457|0,3417(0,3378|0,3339|0,3301|0,3263
"u 26| 0,3947| 0,3902| 0,3857| 0.3813| 0,3770| 0,.3727| 0.36B84| 0.3642|0,3601|0,3560({0,3519|0,3479|0,3439|0,3400|{0,3361(0,3323|0,3285|0,3248|0,3211
.mw 27| 0,3882| 0,3838| 0,3794| 0,3751| 0,3708| 0,3666| 0,3624| 0,3583|0,3542|0,3502(0,3462|0,3423|/0,33584|0,3346|0,3308(0,3270(0,3233|0,3186|0,3160
nD 28| 0.3819| 0,3F76| 0,3733| 0.3691| 0,3649| 0.3608| 0.3567| 0.3526|0,3486|0,3447(0,.3408|0,3369|0,3331|0,3293|0,3256(0,3219|/0,3182|0,.3146|0.,3110
29| 0,3759| 0,3717| 0,3674| 0,3633| 0,3592| 0,3551| 0,3511| 0,3471|0,3432|0,3393[0,3355|0,3317|0,3279|0,3242|0,3205(0,3169|0,3133|0,30858|0,3063
H” 30| 0.3701] 0,.3659| 0,3618] 0.3577| 0,3537| 0.3497| 0.3457| 0,.3418|0,3380|(0,3341({0,3304|0,3266|0,32259|0,3193|0,3157(0,3121|0,3086|0,3051|0,3017
Q
m Constants: -7,424 -0,1288 273,16 John Fleng Steffensen, 2002
VA 4417 53,44
o -2,927 -0,0444
3
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8.3 DAQ-4 Instruction manual

The DAQ-4 instrument is used for data acquisition and relay controlling. It is designed to run
with the software AutoResp™ 4, but it can be used with other applications.

LIST OF PARTS

DAQ-4 instrument

AutoResp™ 4

Power Cord

USB cable

4-fold extension cord for pumps, qty. 2
User manual

SETUP

To power up the instrument connect the power cord to the outlet 100-240 VAC 50-60Hz on the
back side of the instrument. Connect the USB cable to an USB port on your PC and to the
outlet on the front side of the instrument named PC.

USING THE DAQ-4 FOR DATA ACQUISITION

The DAQ-4 instrument acquires data on 6 channels and converts the analog signals to 16 bit
values. Connect the inputs to controller instruments, e.g. OXY-AM to an OXY-REG with a data
cable. If you want to use controller instruments not from Loligo Systems make sure the input
range is 0-5 VDC. The signal must be on pin 1 and GND on pin 4 on an input connector.

Using the DAQ-4 in other applications
It is possible to use the DAQ-4 instrument with other applications than AutoResp™ 4. See
Table 3 for input connections and the wiring diagram on Figur 1.

Table 3

DAQ-4 connector NI-USB 6215 pins Channel name
OXY-CH 1 17 Ail

OXY-CH 2 19 Ai2

OXY-CH 3 21 Ai3

OXY-CH 4 24 Ai4

OXY-AM 26 Ai5

TEMP 29 Ai6

GND 18, 20, 22, 25, 27, 28 and 30 | n.A.
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Figur 1
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For using the LEDs and the relays see Table 4 and the wiring diagram on Figur 1 ~ LOLIGOSYSTEMS.COM

Table 4

DAQ-4 connector NI-USB 6215 pins Channel name linel
FLUSH 6 DO

RECIRC 7 D1

0,/N, 8 D2

TEMP 9 D3

GND 5 n.A.

Through the Solid state PCB in the DAQ-4 instrument it is possible to connect up to 500 W
equipment to every relay.

SPECIFICATIONS
Specifications range
-20°C to +60°C

Common specifications
Supply voltage (universal): 21.6-253 VAC, 50-60 Hz or 19.2-300 VDC

Internal consumption: 3.2 W

Max. consumption: 3.5wW

Isolation voltage (test / operation): 2.3 kVAC / 250 VAC
Signal- / noise ratio: Min. 60 dB (0-100 kHz)
Response time, programmable: 0.4-60 s

Calibration temperature: 20-28°C

Accuracy: <%0.1% of reading
Temperature Coefficient: <%£0.01% of reading/ °C
EMC immunity influence: <£0.5% of reading
Potentiometer input, min: 10 Q

Potentiometer input, max: 100 kQ

Relay outputs

Relay function: Setpoint
Hysteresis, in % / display counts: 0.1-25% / 1-2999
On and Off delay: 0-3600 s

Sensor error detection: Make / Break / Hold
Max. voltage: 250 VRMS

Max. current: 2A/AC

Max. AC power: 500 VA

Max. current at 24 VDC: 1 A
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8.4 TMP-REG manual

The instruction manual for the TMP-REG instrument is included as an individual document.
Please look into the DAQ-PAC-F4X package.

8.5 OXY-REG manual

The instruction manual for the OXY-REG instrument is included as an individual document.
Please look into the DAQ-PAC-F4X package.

8.6 O0OXY-4 Instruction manual

The instruction manual for the OXY-4 fiber optic instrument from PreSens manual is included
as an individual document. Please use this manual for further information about the OXY-4
mini instrument and the OXY-4 software. Please look into the DAQ-PAC-F4X package.
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